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1 Tutorial Preparations 

Welcome to the SCCharts Tutorial! To start, please copy the Eclipse-based KIELER 

SCCharts application from the provided USB thumb drive to your hard drive. 

 

Additionally, you will need a Java 8 SDK on your machine. For Windows and the Lego 

tutorial part you will need the 32bit version of Java and KIELER SCCharts. You will also 

find Java 8 installation files on the USB thumb drive in case you need to install it. 

The following section, Section 1.1a, describes how to copy the appropriate files using a 

concrete example build. Note that the USB stick will contain the most recent build 

instead.  

Alternatively, you read this tutorial documentation after the workshop and thus do not 

have a USB drive with the installation, then you can download the proper release 

candidate or the nightly RCA as explained in Section 1.1b. 

 

1.1a Copy from USB Stick 

(a) Plugin the provided USB stick: /USBStick/KIELERSCCharts/ 

(b) Choose a version suited for your OS and copy it to your computer. 

 

1.1b Download 

(a) Use the following URL:  

http://rtsys.informatik.uni-kiel.de/~kieler/files/release_sccharts_0.12.0/ 

 

or http://tinyurl.com/scchartsrelease12 

 (b) Choose a version suited for your OS and download it to your computer. 
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1.2 Extract / Unzip 

Untar or unzip the KIELER SCCharts Tools in a folder of your harddrive. 

 

1.3 Start KIELER SCCharts Tools 

After you have copied and extracted the KIELER SCCharts Tools, you can start the 

KIELER.exe or KIELER.app. For Mac, you may need to set your security settings such 

that non-appstore applications are allowed to be started.  

 

When you start the KIELER SCCharts Tools for the first time, choose an appropriate 

workspace path on your harddrive. You might later want to copy files there, so 

remember the path. For convenience, you may check the "[x] Use this as the default and 

do not ask again" option. 

   

After that, KIELER should start and you should see the splash screen (see above). Then 

you should see the following welcome screen: 

 

Close this tab. This will bring you to the KIELER SCCharts modeling perspective that 

should look similar to the following screenshot: 
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If your screen is missing the displayed Diagram and KIELER Compiler Selection view 

then you might not have the Java 8 SDK installed or Eclipse may use the wrong Java 

version if you have more than one installed on you system. Please use the provided  

Java 8 installation files on the USB stick. 

Congratulations, you are now ready to model SCCharts and to get used to the interactive 

and incremental model-based KIELER SCCharts compiler. :-) 
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2. Exercise I: Textical Modeling 

Learning Objective: Familiarize yourself with getting examples and textical SCCharts 

modeling. 

2.1 Getting SCCharts Examples 

Click on "File" -> "New" -> "Example..." in the main menu. Then select "KIELER 

Examples" and continue with "Next >". 

   

Now you may choose from various examples.  

 

Choose the AO example by checking its checkbox and clicking "Next >". Then enter a 

proper name that will become the name of the Eclipse project, e.g., call it "AO". 

   

After clicking "Finish", your screen should look similar to the following one. The textual 

SCCharts editor is opened on the left side, the automatically created diagram is shown 

on the right side, the Project Explorer is found on the lower left side and the KIELER 

Compiler Selection is visible in the lower right part of the window. 
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2.2 Textical Modeling Basics 

You may now edit the AO example. Expect the diagram to be updated whenever you 

save your model (<Ctrl>+<S> or <Cmd>+<S>). 

First, let's add another output variable O2 and initialize it to true. Just modify the code 

as follows: 

 

After saving the model, the diagram will update accordingly and show the following 

graphical SCChart: 
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2.3 Textual SCCharts Editor 

Code Formatter 

The editor is equipped with an automated code formatter that can be called using 

<Ctrl>+<Shift>+<F>. This can be useful any time when editing an SCChart. For 

example if you remove some line breaks, your code may look like as follows: 

 

Now, after pressing <Ctrl>+<Shift>+<F>, the code formatter re-arranges the SCT code and makes it 

better readable. It arranges the interface part of a state at the top and separates it and all child 

states by a blank line. Outgoing transitions of a state are put at the bottom of a state declaration, 

after the internal behavior which is declared inside curly brackets "{ ... }", each transition in a new 

line. 

 

Content Assist 

The editor is equipped with a content assist feature which helps you writing SCT code 

more quickly. It also guides you towards syntactically correct SCT code if, for example 

you are not sure about the concrete order of specific keywords. 

By pressing <Ctrl>+<Space> you activate the content assist. 

Try to define a new bool input "B", a new state "dB", and add another transition from 

"wA" to "dB" in case of "B" becomes true. Set "O2" to false only in this transition. 
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Syntax Validation 

The editor is equipped with a syntax validator which checks the SCT model for 

syntactical problems or errors. It is called automatically while typing. You will notice 

possible error or warning markers beside the concerning lines. 

Try to remove the "initial" keyword from the state "wB". 

 

If you hover the mouse over these markers you get a hint what the problem is. In this 

case now all states become not reachable (which is a warning because this does not 

harm but in the end is dead code that will be eliminated). Additionally, as every region 

must have an initial state and the region in "AO" doesn't have one any more now, this 

will result in an error marker telling that there is no initial state found. 
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3. Exercise II: Interactive Compilation 

Learning Objective: Familiarize yourself with the interactive incremental compilation tool 

chain for SCCharts. 

3.1  Interactive Compilation 

Start again with the AO example: 

 

Note that the "O = false" is the use of the initialization feature. While compiling AO, 

initializations are replaced by entry actions which will perform the task of initializing a 

variable. 

To inspect what this concretely means for your model, use the KIELER Compiler 

Selection view and select the "Initialization" feature transformation there. The model 

diagram will update and show the transformed model with entry actions as follows. Note 

that you need to first expand the "Extended SCCharts" feature group and then the 

"Statecharts" feature group in order to see the "Initialization" feature transformation. 

Note that the diagram in the KIELER Compiler Selection re-uses the syntax of SCCharts 

but actually is not an SCChart. Nodes in this diagram represent feature transformations 

or feature groups and transitions represent dependencies. A dependency between two 

feature transformations simply means a certain order for applying these transformations. 

 

For example, because the "Initialization" feature transformation produced new entry 

actions, it makes sense to transform the "Entry Action" feature only after the 

"Initialization" feature. 
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After also selecting the "Entry Action" feature transformation the transformed SCCharts 

looks like follows: 

 

 

3.2  Interactive Compilation Modeling 

Even if you select certain transformations to apply in the KIELER Compiler Selection 

view, you can still edit the original SCChart. The output will then be the updated original 

model with the selected feature transformations applied such that the selected features 

are not contained in the (intermediate) model any more. These feature are replaced by 

more basic features. For example "Entry" is a more basic feature compared to 

"Initialization". 

You can add another interface declaration line, introducing another output variable O2 

that is initialized to false. The intermediate transformed SCChart diagram should look 

like this: 
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You could further experiment with transforming the intermediate result down to a 

Normalized Core SCChart by selecting all "Core SCCharts" feature transformations. The 

result should look similar to the following diagram: 

 

In the normalized form, the SCChart will contain only 5 primitive patterns which are 

immediate Actions, immediate Conditionals, delayed Pause, hierarchy with Fork/Join, 

and Threads starting with an initial node and optionally final states. 

For AO, the normalized form for example reveals that the model never terminates after 

setting "O" to true and reaching "_Depth2". 
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3.3  Generating Code 

Code can be created easily by selecting a transformation from the KIELER Compiler 

Selection in the "Code Generation" feature group. 

 

If you doubleclick the code preview of the Diagram view, the code will open in a textual 

editor. 

Note that the code generation will produce a reset() and a tick() function for every 

SCChart. The original interface is located in the top part of the variable declaration 

followed by internal guards for the circuit-based code generation. 

Note that if you have opened the textual editor then the KIELER Compiler Selection view 

is disabled and will not react to mouse clicks  
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3.4  Generating Hardware Circuits 

You can easily generate HW circuits by just clicking on the "Circuit" feature group.  

 

Note that also the HW circuit synthesis only works for bool values and not for int or other 

kind of values. 
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4. Exercise III: Simulation 

Learning Objective: Familiarize yourself with the simulation feature of KIELER SCCharts. 

The simulation feature helps to understand the dynamics of an SCChart.  

 

4.1  Simulation Perspective 

There is a dedicated perspective for simulating SCCharts. You can reach it by starting to 

type "SCCharts" into the Quick Access textbox at the upper right corner of the window. 

 

After choosing the simulation perspective the window should look like this: 
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4.2  Simulation Control and Initialization  

The synchronous step control buttons can be found in the toolbar. The Data Table has a 

text field which indicates the synchronous tick number. 

  
 

After clicking on the step button (the second button from left), the simulation is 

initialized before the first/initial tick. 

 

The Data Table shows all interface variables and signals that are present in the model. 

The checkbox can be used for input signals to be set to present in the next tick or for 

input int/bool variables to set them to 1/true. The star (*) marks all modified entries 

that are considered the for the next synchronous tick reaction calculation of the SCChart. 

 

 

4.3  Synchronous Ticks 

For example, one could set the input "A" to be true in the initial tick by checking the 

check box (see above screen shot). Then when performing the first real tick computation 

by clicking on the step button again, the active state wA is high-lighted as follows: 
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Note that AO did not react to the input "A" in the initial tick because it is modeled with a 

delayed transition. 

If you set the input "A" for the next (second) tick and do another tick computation then 

the transition to "dA" is taken. Note that you have to click the checkbox of "A" twice in 

this scenario because the first click will modify "A" and unselect the checkbox and the 

second click will select the checkbox again. The simulation is also visualizing taken 

transitions as follows: 

 

Note that the Synchronous Signals view above the Data Table shows the history of the 

signals and (bool/in) variable values according to the presence or true/false or 1/0 value. 
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4.4  Simulating Intermediate Models  

Usually, the input for the simulation is the originally modeled SCChart as it was in the 

example above. 

 

If one would like to investigate the dynamics of intermediate models during compilation 

then  one needs  again the KIELER Compiler Selection view. Stop any running simulation 

execution before selecting feature transformations. 

E.g., select the "Core SCCharts" feature transformation. Note that this will include all 

necessary feature transformations from the "Extended SCCharts" feature group as well. 

If you now initialize the simulation and for the initial/first tick initialize "A" with true 

(checked checkbox) then the behavior why AO does not react to "A" in the initial tick 

becomes more clear: 

 

All the initialization is done which sets the output "O" and "O2" both to false. But then 

the state "wA" is entered without checking for its outgoing transitions in the initial tick 

(because the only outgoing transition is a delayed and not an immediate transition). 

Setting "A" again for the second tick results in the following simulation visualization 

diagram (left). The right diagram shows all following ticks in which AO will never 

terminate. 
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4.5  Hardware Circuit Simulation  

For simulating HW circuits simply click on "Circuit" in the KIELER Compiler Selection view 

and then on the step button to initialize the simulation execution. 

 

Note that additional guards will be shown as an output in the Data Table which are used 

to visualize the active circuit parts. Note that links that are red indicate that the values 

on these links are 1/true and gray links indicate that the values on these links are 

0/false. Multiplexer with a 1/true selector input will forward their upper input, otherwise 

the lower input. 

Note that also the HW circuit simulation only works for bool values and not for int or 

other kind of values. 
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5. Bonus Exercise IV: SCG  

Learning Objective: Familiarize yourself with the control-flow graph representation of 

SCCharts, namely the Sequentially Constructive Graph (SCG). 

Note: If time permits, you are invited to do this bonus exercise. The objective in detail 

is to understand the scheduling of the SCCharts compiler regarding initializations, 

updates, and reads (iur) of variables. In particular, this exercise shows how scheduling 

difficulties can be understood and resolved. 

Recall that SCCharts distinguishes three kinds of variable accesses: 

1. Absolute writes (also called "initializations"): These are always scheduled first. 

Example: X = 0 

2. Relative writes (also called "updates"): These are scheduled after all absolute 

writes. Example: X = X + 1 

3. Reads: These are always scheduled after all (absolute and relative) writes. 

Example: Y = X 

Note, there concurrent absolute writes cannot be scheduled and are not allowed. 

However, sequential absolute writes are scheduled as modeled. 

Concurrent relative writes can always be scheduled because of a commutative and 

associative combine function (e.g., ADD, OR, ...). 

Consider the following SCChart: 

 

Note that this can be scheduled without any problems although there are two absolute 

writes. The first sets O=0 in the initialization and the second sets O=2 in the transition. 

The modeled sequence becomes clear if one has a look at the normalized SCChart.  
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Select all "Core SCCharts" transformations in the "Compiler Selection" view:

 

This can be directly mapped to the SCG representation. Select "SCG" in the "SCGraph" 

feature group: 

 

The "entry" node is the start of the (single) thread here. If started, first O is initialized to 

0 then a pause-construct ("surface" + "depth") is entered. In the next tick this pause-

construct is left. Then, "A" is checked. If "A" is false (else branch), then the pause-

construct is entered again. If "A" is true (then branch), then the O is set to 2 and 

another pause-construct (of the other former state "dA") is entered. As the program 

never terminates, the "exit" node is left unconnected. 
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Now modify the original SCChart and add a during action that sets O to 4: 

 

If you now select all "SCGraph" transformations, then you notice that the SCG is not 

ASC-schedulable: 

 

To investigate the problem, take a look at the normalized SCChat, selecting only all 

"Core SCCharts" transformations again: 
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The initialization of O=0 is still not a problem. But the during actions is executed 

concurrently such that this results in a concurrent O=4 and O=2 absolute write. Looking 

at the SCG you can visually see the dependencies and this so called write-write-conflict: 

 

A solution is to make one of these absolute writes a relative write, e.g., using addition as 

a proper combination function: 
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As expected, the absolute write is now scheduled before the concurrent relative write. 

And the SCG is now properly schedulable: 
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6. Lego Mindstorms Preparations 

Before we are able to use SCCharts with Lego Mindstorms, some preparation is 

necessary. 

Please note that most limitations that are described here are limitations of 

leJOS or its Eclipse plugin, not of the KIELER SCCharts tools.  

 

If you do not want to struggle with these extra preparations, then you are invited to use 

our provided DOWNLOAD STATION. Please use one of the USB sticks to transfer your 

SCT textual SCChart file to the Download Station. 

 

Note that the installation procedure varies depending on your operating system. In 

essence, two steps are necessary.  

1. Lego Mindstorms driver 

2. LeJOS project  

First, the Lego device needs to be registered in your operating system. Then the leJOS 

project needs to be installed. This provides a Java capable firmware for the Lego brick 

and the uploading facility. The leJOS plugin for Eclipse should be available in the KIELER 

SCCharts tools already. It will use the installed leJOS project to compile, upload, and run 

the Java files that are generated from SCCharts. 

 

6.1 Windows 

For Windows you will need the 32bit version of both (a) KIELER SCCharts and (b) Java 

(see Section 1). Make sure that the 32 Bit Java version is available for the KIELER 

SCCharts RCA. You may need to check your PATH variable or edit the kieler.ini of the 

SCCharts RCA in rare cases. 

USB Driver (Fantom) 

For Windows you will need the Lego Fantom Driver which you may download here or 

install from the provided USB stick: 

https://mi-od-live-s.legocdn.com/r/www/r/mindstorms/-

/media/franchises/mindstorms%202014/downloads/firmware%20and%20software/nxt%

20software/nxt%20fantom%20drivers%20v120.zip 

or 

http://tinyurl.com/legodriver  

or  

the file /USBStick/WindowsMacFantomDriver/NXT Fantom Drivers v120.zip  

(from the USB Stick) 

After the installation, connect the Mindstorms brick with a USB cable. Check whether you 

see the Lego Mindstorms device in the Windows Device Manager: 
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Install LeJOS 

You will further need leJOS which you will get from the USB stick or from the following 

URL: https://sourceforge.net/projects/nxt.lejos.p/files/ 

or use the following tiny URL: http://tinyurl.com/lejosinstall 

Note, that you will need a version that fits to the flashed firmware on the brick. Currently 

most of our bricks run with version 0.9.1. 

For Windows, you will mostly like to run the /USBStick/leJOS/leJOS_NXJ_0.9.1beta-

3_win32_setup.exe executable. 

 

 

6.2 Mac OSX 

For MaxOSX you need to start KIELER SCCharts from the command line. You need to set 

two path variables before (for details, see below), namely NXJ_HOME and 

LEJOS_NXT_JAVA_HOME. 

Further, leJOS needs a 32 Bit Java and for MaxOSX the most recent 32 Bit Java is 

Version 1.6. Hence, you need to install Java 1.6 in addition from Oracle Homepage or 

from the USB stick. 

For KIELER SCCharts you still need Java 1.8. 

 

If you need to install Java 1.6 and Java 1.8, please install Java 1.8 first and then Java 

1.6 as the Java 1.8 installation procedure is known to possibly corrupt a previously 

installed Java 1.6 on MacOSX. 
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USB Driver (Fantom) 

For MacOSX you will need the Lego Fantom Driver which you may download here or 

install from the provided USB stick: 

https://mi-od-live-s.legocdn.com/r/www/r/mindstorms/-

/media/franchises/mindstorms%202014/downloads/firmware%20and%20software/nxt%

20software/nxt%20fantom%20drivers%20v120.zip 

 

or 
 

http://tinyurl.com/legodriver  
 

or 

 

the file /USBStick/WindowsMacFantomDriver/NXT Fantom Drivers v120.zip  

(from the USB Stick) 

 

Install LeJOS 

The OS X edition of leJOS is distributed as a .tar.gz archive. Untar the archive to a 

location of your choice. You may delete the build subfolder, since it is required for Linux 

only. 

tar -xvzf leJOS_NXJ_0.9.1beta-3.tar.gz 

Set the NXJ_HOME path variable in the KIELER/Eclipse preferences and let it point to 

your leJOS installation (the root folder, not the bin folder). See explanation in the end. 

Also set the leJOS path variable for your shell: 

export NXJ_HOME="<your leJOS installation root directory>" 

 

Install Java Version 1.6 32 Bit 

For MaxOSX, you need a 32 Bit version of Java. The latest version of Java that supports 

32 Bit on a Mac is 1.6. Unfortunately, all newer version do not even support a 32 Bit 

mode (which often could be enabled using the -d32 parameter). 

Hence, you need to download Java 1.6 32 Bit and install it parallel to you Java 1.8, 

which you need for working with KIELER SCCharts. 

You get the installation bundle here: 

http://support.apple.com/downloads/DL1572/en_US/javaforosx.dmg 

or 

http://tinyurl.com/java16mac 

or from the provided USB stick. 

For leJOS to find Java 1.6, you need to set an environment variable. 

export LEJOS_NXT_JAVA_HOME ="<your Java 1.6 installation root 

directory>" 
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Start KIELER w/ 32Bit 

You need to set the two path variables NXJ_HOME and LEJOS_NXT_JAVA_HOME before you 

start KIELER SCCharts from the command line. 

Then, navigate to the folder where you expanded KIELER SCCharts and start it using  

 

./kieler 

 

6.3 Linux 

Prepare Java 

If you don’t have a JDK yet, download and install the newest release from oracle for your 

system or use the Java SDK provided on the USB stick. LeJOS needs to know the 

location of this JDK. This can be achieved by creating an environment variable 

JAVA_HOME. On most Linux systems, environment variables are edited in a file .profile 

in your home directory. Thus add 

export JAVA_HOME="/opt/java/jdk1.8.0_60" 

to the end of ~/.profile. Thereby the path to java must be adapted to your system. 

Logout and login again to let the change take effect. You can test this by typing  

echo $JAVA_HOME. The command should print the path you configured. 

 

USB Driver 

Linux systems require the packages libusb and libusb-dev to connect via USB with a 

Mindstorms brick. On Ubuntu, these can be installed from command prompt using 

sudo apt-get install libusb-0.1 libusb-dev 

To use the USB connection as non-root user, create a file /etc/udev/rules.d/70-lego.rules 

with the following content (4 lines in total): 

# Lego NXT brick in normal mode 

SUBSYSTEM=="usb", DRIVER=="usb", ATTRS{idVendor}=="0694", ATTRS{idProduct}=="0002", GROUP="lego", MODE="0660" 

# Lego NXT brick in firmware update mode (Atmel SAM-BA mode) 
SUBSYSTEM=="usb", DRIVER=="usb", ATTRS{idVendor}=="03eb", ATTRS{idProduct}=="6124", GROUP="lego", MODE="0660" 

Then create a group named lego and add your user to this group using the following 

commands: 

sudo groupadd lego 

sudo gpasswd -a <username> lego 

sudo udevadm control --reload-rules 
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Install LeJOS 

You will further need leJOS, which can be downloaded from the following URL: 

https://sourceforge.net/projects/nxt.lejos.p/files/ 

Note, that you will need a version that fits to the flashed firmware on the brick. 

Currently, most of our bricks run with version 0.9.1. 

For Linux, you have to download and extract the tar.gz file: 

tar -xvzf leJOS_NXJ_0.9.1beta-3.tar.gz 

Afterwards you will need to build the Java Native Library that ships with leJOS. To do so,  

you will need ant. 

sudo apt-get install ant 

Then navigate to the ./build directory in your leJOS installation and execute ant from 

terminal. The release should build without errors. 
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7. Exercise V: SCCharts for Lego Mindstorms  

Learning Objective: Familiarize yourself with the SCCharts template environment using 

the example of Lego Mindstorms as an example embedded target. 

In this exercise you will create a simple SCChart which will wait on the OK button of the 

Lego Midstorms and output "Hello Synchron" to its display. 

 

7.1 Creating an SCCharts Project 

Click on "File" -> "New" -> "SCCharts Project" in the main menu. 

 

 

The select "Mindstorms NXJ" and click on "Finish" (left figure). Note that on MacOSX you 

need to select "Mindstorms NXJ (MacOSX)". 

 

You will be prompted another New Java Wizard now (right figure). Enter a project name, 

e.g., "Synchron" and again click on "Finish". Do not switch to the Java perspective, 

if you are prompted to do so.  Attention: Due to leJOS limitations the name of 

the project must not exceed 8 characters! 
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The screen should look as follows: 

 

 

7.2 Modeling SCCharts with Environment Snippets 

You can now start modeling with SCCharts and its Lego Environment Extension. Note the 

"snippets" folder where you can draw from various Lego I/O examples. 
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Modify the example as follows: 

 

The wrapper annotation "Enter" will enforce that the automatically generated 

environment wrapper code will be mapped to the "isEnterDown" boolean variable such 

that "isEnterDown" is true iff the Lego Mindstorms Enter button is pressed. 

The wrapper annotation "Print" will enforce that the automatically generated 

environment wrapper code will print the content of the "outputText" string variable on 

the Lego Minstorms display unit. Further snippets are available in the "snippets" folder 

(see above). Each snippet is a Freemarker template and comes with a short example. 

 

Further Snippet Examples 

Light-Sensor:  

 
 

Motor-Actuator: 

 
 

Time Input: 

 
 

Touch Sensor: 

 
 

Lamp: 

 
 

Beep: 

 
 

Draw String to pos (x,y): 

 
 

Draw Int to pos (x,y): 
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7.3 Download & Run 

Please ensure that the Lego Mindstorms brick is switched on now and connected via 

a USB connection. 

To upload right-click the sct file and select "Run As"->"KiCo Compilation" (see next 

page). This will automatically generate a Java file for the SCChart under a new "kieler-

gen" folder. It will further generate environment wrapper code and try to upload and run 

the class files to the Lego brick.  

  

The program should be uploaded to the brick and started. You should see the following 

screen on the display unit (left photo): 

     

After pressing the (orange) Enter button, the output "Hello Synchron" should appear on 

the display unit (right photo). 
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If you encounter Problems 

1. If you get the following error: 

Linking ... 

Program has been linked successfully 

Uploading ... 

leJOS NXJ> Searching for any NXT using Bluetooth inquiry 

BlueCove version 2.1.0 on winsock 

leJOS NXJ> Failed to find any NXTs 

leJOS NXJ> Failed to connect to any NXT 

No NXT found - is it switched on and plugged in (for USB)? 

Then most likely the NXT is not turned on (any more) or it is not connected via USB. 

Note that the NXT switches off automatically after some time. 

 

 

2. If you have problems uploading your SCCharts to the Lego Mindstorms brick, you may 

need to check the LeJos configuration in the preference settings.  

Click on "Window"->"Preferences" and select "leJOS NXJ". Then, check the path to the 

leJOS installation. 
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8. Exercise VI: SCCharts Pathfinder  

Learning Objective: Use your knowledge about SCCharts and the KIELER SCCharts 

tooling to solve a more complex embedded system task. 

 

This exercise is not meant to be completely solved in the short time frame of 

this tutorial workshop slot. 

 

However, you are invited to solve it during the SYNCHRON workshop until Friday 

morning whenever time permits (breaks, evenings, ...). We will leave the robots, the 

Download Station, and the mat for your pleasure (hopefully J).  We may assist you any 

time; just let us know.  

 

8.1 The Task 

We brought several Lego Mindstorms that were build by some of your students. 

Additionally, we brought you an exercise mat with a printed path. 

Your task is to build an SCCharts controller for the Mindstorms robot such that the robot 

follows the line from "Start" to "Finish" reliably and as fast as possible. 

 

 

 

 

 

8.2 Your Solution 

We would be happy if you share your solution with us. You are happy to add comments 

about what you liked and what you would like us to improve in the SCCharts language 

and tooling. 

We would appreciate if you send us your solution via email to:  

kieler@informatik.uni-kiel.de 
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9. Questions & Feedback 

We'd like to encourage you to give us your valuable feedback on anything that comes to 

your mind when using the KIELER SCCharts tools. 

 

9.1 Questions 

For questions, you may use the following link that takes you to our Confluence Questions 

section: 

https://rtsys.informatik.uni-kiel.de/confluence/questions 

or  

http://tinyurl.com/kielerquestions 

 

9.2 Report Errors 

If you encounter any errors or faulty behavior or if you have concrete feature requests, 

then you may use our Jira bug tracker here: 

https://rtsys.informatik.uni-kiel.de/jira/    or    http://tinyurl.com/kielerbug 

 
 

If you do not have an account yet, please sign up for one. If you do not like to open an 

account, you may also send us your bug report via email:  

kieler@informatik.uni-kiel.de 

 

9.3 Feedback 

We'd also like to hear about your valuable feedback in general. We kindly invite you to 

participate in the following survey (see next page). 

Optionally, you may also send us an email: kieler@informatik.uni-kiel.de 
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 SCCHARTS SURVEY FORM   

Have you use KIELER SCCharts before?  Can you image to use KIELER SCCharts in the future? 
 Yes 

Please let us know in the comments below, where you used it. 

  
Yes            in class  in projects  for fun 

 No   No  

     

     

 

Rate the quality of the SCCharts development tools you worked with. 

Creation/Modeling of models:  Debugging of models: 

 Professional 
as other mature open source or commercial products 

  Professional 
as other mature open source or commercial products 

 Advanced  
as other smaller commercial or open source products 

  Advanced  
as other smaller commercial or open source products 

 Ok 
as beta version of commercial software or Freeware 

  Ok 
as beta version of commercial software or Freeware 

 Hardly usable 
like alpha versions or private/obsolete projects 

  Hardly usable 
like alpha versions or private/obsolete projects 

 

Interactive compilation/code generation:  Wrapper\Template code generation: 
 Professional 

as other mature open source or commercial products 

  Professional 
as other mature open source or commercial products 

 Advanced  
as other smaller commercial or open source products 

  Advanced  
as other smaller commercial or open source products 

 Ok 
as beta version of commercial software or Freeware 

  Ok 
as beta version of commercial software or Freeware 

 Hardly usable 
like alpha versions or private/obsolete projects 

  Hardly usable 
like alpha versions or private/obsolete projects 

 

Understanding the language semantics:  User interface: 

 Professional 
as other mature open source or commercial products 

  Professional 
as other mature open source or commercial products 

 Advanced  
as other smaller commercial or open source products 

  Advanced  
as other smaller commercial or open source products 

 Ok 
as beta version of commercial software or Freeware 

  Ok 
as beta version of commercial software or Freeware 

 Hardly usable 
like alpha versions or private/obsolete projects 

  Hardly usable 
like alpha versions or private/obsolete projects 

 

Comments on KIELER SCCharts: 
(E.g., what do you think is missing for the release of the KIELER SCCharts development tools?) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

    

Comments on this tutorial: 
(E.g., what can we do to improve it? Was it helpful? Did you enjoy it?) 

 

 

 

 

 

 

 

    

You can use the back page of this form to leave more  

detailed comments and/or suggestions.  

We appreciate your feedback! Thank you very much! 
 

Rev. 1.1t Rev. 1.1t 
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